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Anotácia: 

 Práca sa zaoberá problematikou erózie pôdy, jej posudzovaním pomocou 

geografického informačného systému a univerzálnej rovnice straty pôdy na vybranom území 

povodia toku Teplica. V mojej práci sme najskôr charakterizovali problematiku geografických 

informačných systémov, vodnej erózie a formy ochrany pôdy, a taktiež záujmové územie. 

Ako vstupné údaje mi slúžili rastrové a vektorové vrstvy s informáciami o využití 

záujmového územia, pôdna mapa, mapa BPEJ, mapa cestných komunikácii, riečnej siete 

a digitálny model reliéfu. Samotný výpočet erózneho odnosu som realizovala v prostredí 

geografického informačného systému ArcGIS Desktop 10.1.  

Výstupom tejto práce sú účelové mapy, na ktorých sú lokalizované erózne ohrozené 

plochy a mapa protieróznych opatrení (pásové pestovanie plodín). 

 

Kľúčové slová: erózia, vodná erózia, erózna ohrozenosť pôd, geografické informačné systémy 

(GIS), univerzálna rovnica straty pôdy. 

Annotation:  

 This work deals with the erosion of soil, its assessment using the Geographic 

Information System and the Universal Soil Loss Equation for the selected river basin Teplica. 

At first I described the problems of Geographic Information System, water erosion and land 

forms of protection and also the area of interest. As an input data I used raster and vector 

layers with information on the respective area, the soil map, Soil valuation ecological units 

map (BPEJ) and road map, river network and the digital elevation model of the basin. The 

actual calculation of sediment erosion is realized in the Geographic Information System 

ArcGIS Desktop 10.1.  

The outputs of this work are specific maps with localized erosion risks and map for 

erosion control (planting crops in rows). 

 

Key words: erosion, water erosion, soil erosion vulnerability, geographic information system 

(GIS), universal soil loss equation. 
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Úvod  

Problematika je zameraná na vodnú eróziu v povodí, jej posudzovanie pomocou 

geografických informačných systémov a univerzálnej rovnice straty pôdy (USLE) 

na vybranom území povodia toku Teplica, zároveň na návrh a vizualizáciu protieróznych 

opatrení. Predmetom práce je umožniť širokému okruhu verejnosti orientovať sa 

v problematike príčin a následkov erozívnych vplyvov, a zároveň poukázať na rôzne spôsoby 

opatrení zabraňujúcich k ich vznikom. 

1 Cieľ práce 

Cieľom predkladanej záverečnej práce je rozbor problematiky zameranej na eróziu 

pôdy (so zreteľom na vodnú eróziu pôdy), poukázanie na problémy s ňou súvisiace 

na modelovom území povodia Teplica a návrh vhodných protieróznych a vodohospodárskych 

opatrení.  

Pre naplnenie uvádzaných cieľov je potrebné: 

 zoznámenie sa s problematikou eróznej ohrozenosti pôdy a s metódou univerzálnej 

rovnice straty pôdy,  

 popis metodík použitých pri modelovaní eróznej ohrozenosti pôdy, modelovania 

povodňového rizika (ArcGIS Desktop 10.1), 

 popis dátových vstupov a ich spracovanie (ArcGIS Desktop 10.1), 

 definovanie dažďového faktora a faktora náchylnosti pôdy na eróziu, výpočet 

topografického faktora, 

 definovanie faktora ochranného účinku vegetácie podľa osevných postupov, 

 analýza výsledkov, odhad ohrozenosti územia (povodia) eróziou pôdy v prostredí 

GIS v povodí, 

  vymedzenie lokalít ohrozených priamym odtokom a návrh vhodných 

protieróznych opatrení, 

 zhodnotenie výstupov, výsledkov a máp. 

2 Prehľad o súčasnom stave riešenej problematiky 

2.1 Význam a účel pozemkových úprav 

Pozemkové úpravy sú jedným z najúčinnejších prostriedkov postupného zvyšovania 

rozmanitosti štruktúry krajiny, okrem toho prispievajú k zvyšovaniu jej ekologickej stability. 
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Ide o cieľavedomé, plánovité a organizované využívanie, zúrodňovanie, zveľaďovania 

a ochranu pôdneho fondu. Účel, obsah a forma je zvyčajne odrazom politických 

a hospodárskych pomerov v danej krajine. 

„Cieľom pozemkových úprav je znížiť výraznú rozdrobenosť pozemkov 

na Slovensku. To znamená, že vlastník súčasného veľkého množstva parciel sa stane 

vlastníkom pozemkov sústredených v jednej lokalite so snahou priblížiť sa k tomu ideálnemu 

podielu, čo je vlastne jedna jednina“. 

„Dnes máme na Slovensku pozemky v maximálnej miere neprístupné. 

V rámci pozemkových úprav sa budeme snažiť sprístupniť ich, a preto je súčasťou komasácie 

aj regulácia vodného režimu, protierózne opatrenia, výstavba prístupových ciest k pozemkom 

a výsadba vetrolamov“. 

Podstatou pozemkových úprav je účelné prerozdeľovanie pozemkov. V prípade 

komplexne poňatých pozemkových úprav sú poľnohospodárske pôdy určené na vyčlenenie 

nových pozemkov a vo väčšine prípadov sú vytvárané nanovo z dôvodu reorganizácií cestnej 

siete, vytvorí sa nový systém protieróznej a protipovodňovej ochrany, ekologickej stability 

a pod.  

2.2 Erózia pôdy   

Eróziu chápeme ako deštrukciu (rozrušovanie, vymieľanie, drobenie až po denudáciu) 

povrchu - pôdy, zvetralinového plášťa, prípadne hornín. Niekedy sa priraďuje aj 

premiestňovanie, odnášanie (transport) čiastok, kde nastáva jej hromadenie v spôsobe nánosu, 

respektíve z látok, pôvodne deštruovanej hmoty, pôsobením gravitácie a príčinou povrchovej 

činnosti vody, vetra, ľadu, snehu a iných činiteľov, vystupujúcich v reliéfotvorných 

procesoch. Erózna činnosť prebieha v prirodzených podmienkach pozvoľne, z hľadiska 

ľudskej generácie nepozorovane. Z hľadiska tvorby a uchovania pôdy je dôležité dbať 

na intenzitu erózie. Za kritickú hranicu intenzity erózie sa považuje bod, pri ktorom strata 

pôdy sa rovná kvantitatívnej tvorbe pôdy alebo je od nej menšia. Erózia, ktorej intenzita 

neprekročila kritickú hranicu sa nazýva neškodná, a ak je kritický bod prekročený, hovoríme 

o erózii škodlivej.  

2.2.1 Erózne ohrozenie  

V rámci Slovenskej republiky najväčšie škody sú spôsobené vodnou a veternou 

eróziou, ktoré sú ovplyvnené ľudskou činnosťou. Potenciálne ohrozená poľnohospodárska 
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pôda, zasiahnutá procesmi vodnej erózie, predstavuje  43,3 %. Potenciál veternej erózie pôdy 

je v Slovenskej republike relatívne nízka. Extrémne ohrozených je 1,3 % 

poľnohospodárskych pôd; na 1,9 % výmery prebieha vysoká intenzita veternej erózie; 

strednou intenzitou je ohrozovaných 3,0 % výmery.  

Pod vodnou eróziou chápeme odnos pôdnej hmoty po stranách stekajúcou vodou 

(ronom), pochádzajúcou z extrémnych zrážok a náhleho topenia snehu, jej premiestňovanie, 

a zároveň jej ukladanie na inom mieste. Vodná erózia vyvolaná intenzívnymi zrážkami je 

v našich podmienkach oveľa významnejšia ako erózia, ktorá je  podmienená topením snehu. 

Je vyvolaná kinetickou energiou dažďových kvapiek dopadajúcich na povrch pôdy 

a pomocou mechanickej sily tečúcej vody. Priamy odtok vzniká z prívalových alebo 

dlhotrvajúcich zrážok, zo snehových vôd pri jarnom topení snehu, a tiež koncentráciou vody 

v prirodzenej i umelej ideografickej sieti. Stojatá voda morská, jazerná a z rybníkov spôsobuje 

pobrežnú eróziu, podzemné vody, najviac tejto vody je v krasových útvaroch, vyvolávajú 

okrem mechanickej aj chemickú eróziu. 

Vodná erózia sa prejavuje na povrchu pôdy selekciou pôdnych častíc a vznikom 

odtokových dráh rôznych rozmerov (rýh, výmoľov), v miestach sú výrazné koncentrácie 

priameho odtoku a môžu sa vytvárať strže. Intenzita vodnej erózie je daná podľa vlastností 

zrážok a priameho odtoku, pôdnymi pomermi, morfológiou územia (sklonom, dĺžkou a 

tvarom svahov), vegetačnými pomermi a spôsobom využitia pozemkov, vrátane používaných 

agrotechnológií. 

2.2.2 Prieskum ohrozenosti územia vodnou eróziou 

Metódy posúdenia ohrozenosti územia vodnou eróziou sú: 

1. Orientačné posúdenie na základe BPEJ, 

2. Podrobné posúdenie ohrozenosti územia vodnou eróziou na základe univerzálnej 

rovnice a revidovanej univerzálnej rovnice (USLE, RUSLE). 

  

Oba empirické modely ako sú RUSLE a USLE sú na princípe prípustnej straty pôdy 

na jednotkovom pozemku, ktorého parametre sú definované a odvodené z rozmerov 

štandardných elementárnych odtokových plôch o dĺžke 22 m sklone 9 %, ktorých povrch je 

po každom prívalovom daždi mechanicky kultivovaný v smere sklonu svahu ako úhor. 

Hodnota prípustnej straty pôdy nám slúži na stanovenie miery erózneho ohrozenia pozemku a 

je definovaná ako maximálna veľkosť erózie pôdy, ktorá dovoľuje trvale a ekonomicky 
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dostupne udržiavať dostatočnú úroveň úrodnosti pôdy. Výpočet straty pôdy podľa 

Wischmeiera-Smitha je vyjadrený podľa vzorca:  

G = R.K.L.S.C.P v t /ha za rok/  

kde:  

G= je strata pôdy [t.ha.rok-1] 

R = faktor eróznej účinnosti prívalového dažďa [MJ.ha-1.cm.hod-1] 

K = faktor náchylnosti pôdy na eróziu [t.ha.rok-1] 

L = faktor dĺžky svahu [-] 

S = faktor sklonu svahu [-] 

C = faktor ochranného vplyvu vegetácie [-] 

P = faktor účinnosti protieróznych opatrení [-] 

Na stanovenie hodnôt faktorov erózneho splachu pôdy, ktoré tvoria vstupné údaje pre 

výpočet eróznych strát pôdy je potrebné zabezpečiť presné podklady:  

 pedologické (terénne, laboratórne)  

 geodetické (polohopisné a výškopisné)  

 výrobno-pestovateľské  

 rekognoskácie terénu  

 doplňujúce  

R – faktor eróznej účinnosti prívalového dažďa. Pod týmto pojmom sa rozumie 

       súčin celkovej kinetickej energie dažďa a jeho maximálnej 30-minútovej 

       intenzity.  

K – faktor náchylnosti pôdy na eróziu. Je definovaný ako odnos pôdy v (t/ ha),  

       pripadajúci na jednotku dažďového faktora R zo štandartného  

       pozemku – nakypreného čierneho úhora – so sklonom povrchu s = 9 %, pri   

       dĺžke 22,13 m.  

L – faktor dĺžky svahu predstavuje pomer straty pôdy na jednotku plochy 

      záujmového celku k strate pôdy na štandartnej porovnávacej ploche dlhej 

      d = 22,13 m. Hodnota faktora dĺžky svahu L určuje výraz: 

                  L = (d / 22,13)p 

                           taktiež vzorcom:   

                   

                Exponent p je funkciou sklonu svahu S v %. Má nasledujúce hodnoty: 

     p = 0,3 pre sklon svahu s = do 3 %  
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     p = 0,4 pre sklon svahu s = od 3 % do 5 %  

     p = 0,5 pre sklon svahu s = 5 % a viac  

S – faktor sklonu svahu  

Faktor sklonu svahu S predstavuje pomer straty pôdy na jednotku plochy záujmového 

celku k strate pôdy na štandardnej porovnávacej ploche so sklonom S = 9 %. Stanovenie 

hodnoty faktora sklonu svahu S sa vykonáva v závislosti od tvaru priečneho profilu svahu. 

V prípade priameho svahu sa výpočet hodnoty faktora S vykonáva pomocou vzorca: 

S = (0,43+0,30.s%+0,043. s%2) / 6,613 

C – faktor ochranného vplyvu vegetácie. Ochranný vplyv vegetácie – stojacej alebo 

ukončenej na pôdnom povrchu spočíva v tom, že v závislosti od jej zapojenia: 

 chráni povrch pôdy pred vznikom kvapkovej erózie tlmením nárazovej kinetickej 

energie dažďových kvapiek tuhosťou, alebo proti poľahnutím porastu na pôdny 

povrch  

 chráni pôdny povrch pred vznikom plošnej a výkonnej erózie koreňovým systémom a 

proti poľahom porastu na pôdu  

 zadržiava zrážkové zaťaženie pôdneho povrchu na stojacej alebo uloženej rastlinnej 

hmote  

P – faktor účinnosti protieróznych opatrení. Účinnosť protieróznych opatrení sa 

vyjadruje hodnotou faktora P, ktorá sa približuje ku skutočnosti iba za predpokladu, že 

pozemok, ktorý je nimi chránený, je dokonale izolovaný od vplyvu „cudzej vody“. 

Pomocou rovnice USLE sa vykonáva hlavne výpočet momentálnej erodovateľnosti 

pôdy G, t. j. momentálneho stupňa eróznej ohrozenosti pôdy plošného celku, ktorý sa 

porovnáva s budúcim navrhovaným stavom protieróznej úpravy.  

3 Charakteristika záujmového územia 
3.1 Vymedzenie riešeného územia 

Riešené územie tvorí povodie toku Teplica, je strediskom rázovitej kopaničiarskej 

oblasti medzi Záhorím na jednej strane a Považím na druhej strane a hraničí s Bielymi 

Karpatmi. Územie sa rozprestiera na západe Slovenskej republiky a jeho západná hranica je 

súčasne i štátnou hranicou s Rakúskom a Českou republikou - okresom Hodonín. Celková 

výmera povodia Teplica tvorí 7598,91 ha, čo predstavuje: orná pôda – 6122 ha,  vinice – 99 

ha, sady – 30 ha, vodné plochy – 41 ha, lesy – 3105 ha, zástavba – 348 ha. 
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Povodie Teplica sa zaraďuje k regiónu Záhorie, čo predstavuje pohorie Malé Karpaty, 

ktoré ho oddeľuje od ostatnej časti Slovenska. Záhorie delíme z hľadiska polohy sever – juh, 

na Dolné Záhorie a Horné Záhorie. Môžeme povedať, že Dolné Záhorie má blízke väzby 

práve na Dolné  Rakúsko, preto je označované za dolné (po obec Moravský Sv. Ján, v ktorej 

je hraničný  priechod Moravský Sv. Ján – Hohenau) a Horné Záhorie, ktoré má zasa blízke 

väzby na  Českú republiku, na severozápade. Prirodzenú prekážku tvorí pohorie Malé Karpaty 

a na severovýchode Myjavská pahorkatina. 

Všetky pohoria a pahorkatiny boli vytvorené vrásnením, v jadre sú zložené 

z morských usadenín (flyš) - kryštalické bridlice vápencov, dolomitov, slieňov, pieskovcov, 

kremencov, žuly a ruly. Povrch na území je pokrytý porastom všetkých druhov stromov (buk, 

dub, hrab, jedľa, smrek, borovica, javor). 

4 Výpočty a riešenia 
4.1 Odhad ohrozenosti povodia vodnou eróziou 

Na základe zistených údajov sme v povodí toku Teplica vytýčili územie, ktoré je 

najviac erózne ohrozené. Z podkladov Landuse (Obr. 4.1), digitálneho modelu reliéfu, viď 

(Obr. 4.2), vodných tokov, cestných komunikácií, hranice povodia sme si určili hranice 

erózne uzavretého celku. Hranice celku nám tvoria les, ostatné plochy, cestné komunikácie, 

hranica katastra. Vypracované výstupy máp sme orezali podľa hranice záujmového územia 

pomocou Data Managment Tools → Raster → Raster Processing →  Clip.  

 

Obr. 4.1: Mapa Landuse 
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Obr. 4.2:  Hypsometria                  

 

Obr. 4.3: Schematizácia výypočtu USLE 

Výpočet sme realizovali v prostredí ArcGIS 10.1 s rozšírením Spatial Analyst 

s použitím prídavného programu, t. j. rozšírenia HydroTools. GIS používa dva základné 

modely geodát – vektorový a rastrový (50x50 – veľkosť gridu). GIS používa dva základné 

modely geodát – vektorový a rastrový. Pre riešenie úlohy výpočtu straty pôdy v záujmovom 

území a jej priestorové vyhodnotenie sa použije rastrový model, ktorý je vhodný pre spojité 

údaje (digitálny model reliéfu, faktor LS) a umožňuje pomocou mapovej algebry, ako jazyka 

gridu, uskutočniť riešenie Univerzálnej rovnice straty pôdy od Wischmeiera a Smitha (1978) 

ako súčin informačných vrstiev, predstavujúcich jej jednotlivé faktory, tak aj výpočet 

niektorých jej faktorov. Pred samotným výpočtom, pomocou rovnice USLE v prostredí GIS, 
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je potrebné pripraviť dátové vrstvy, ktoré predstavujú jednotlivé faktory rovnice viď (Obr. 

4.3). 

 Faktor eróznej účinnosti dažďa (R) sme určili na základe hodnoty pre Slovensko poľa 

F. Alenu v hodnote 30.  

 Faktor náchylnosti pôdy na vodnú eróziu (K) bol určený podľa pôdnych druhov 

na základe geologickej mapy. Pre pôdne druhy v záujmovom území som priradila 

hodnoty pomocou Attribute Table → Add Field → Field Calculator → Polygon to 

Raster. Hodnoty Kpriem. faktora (podľa Alenu, 1991) piesočnato hlinitá pôda 0,35, 

hlinitá 0,45 a  ílovito hlinitá 0,60, grafické znázornenie viď (Obr. 4.4) 

 

Obr. 4.4:  Pôdne druhy                         

 

Obr. 4.5:  Faktor erodovateľnosti pôdy (K) 
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 Faktor dĺžky svahu (L) sme odvodili z hydrologicky korektného DMR, a následne sme 

vyhladili depresie pomocou Spatial Analyst Tools → Hydrology → Fill (Obr. 4.7). 

Následne sme odvodili mapa smeru odtoku, t. j. mapa smeru najstrmšieho spádu 

každej bunky k susednej, nižšie položenej bunke, pomocou vstupného údaju Fill cez 

Flow Direction (Obr. 4.6). Ďalej cestné komunikácie a ostatné plochy (takzvané naše 

bariéry) prevedieme na raster pomocou Polygon to Raster a pomocou Reclasiffy im 

priradíme hodnotu No Data. Na získanie dĺžky odtoku bez bariér cez Raster Caclulator 

ich vynásobíme s dĺžkou odtoku. K výpočtu faktora dĺžky svahu potrebujeme samotnú 

dĺžku svahu, ktorý určíme na základe vstupného údaju Flow direction pomocou Flow 

Length (Obr. 4.7). Samotný výpočet realizujeme v Spatial analyst tools → Map 

algebra → Raster Calculator pomocou vzorca.    

 

Obr. 4.6: Úprava depresií (FILL), Smer odtoku (FLOW DIRECTION) 
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 Faktor sklonu svahu sme vytvorili z DMR s funkciou Slope – sklony v stupňoch 

(Obr. 4.8), následne sme určili faktor sklonu cez Raster Calculator pomocou 

nasledujúceho vzorca (Obr. 4.8): 

 

  
 

Obr. 4.8: Sklonové pomery, Faktor sklonu ( I ) 

Obr. 4.7: Dĺžka svahu (FLOW LENGTH), Faktor dĺžky svahu (L) 
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Obr. 4.9: Faktor ochranného vplyvu vegetácie (C) 

 Faktor ochranného vplyvu vegetácie sme určili na základe tabuľky pre priemerné 

ročné hodnoty faktora C pre poľné plodiny podľa Wischmeiera a Smitha (1978), 

(Alena, 1986). Ako C1 som zvolila hodnotu 12 pre pšenicu ozimnú, C2 - 0,17 pre raž, 

jačmeň ozimný a C3 – 0,44 pre zemiaky. Tieto hodnoty som priradila pomocou 

Attribute Table → Add Field → Field Calculator → Polygon to Raster (Obr. 4.9). 

 Faktor účinnosti protieróznych opatrení sme do výpočtu nezahrnuli, resp. jeho hodnotu 

sme stanovili rovnú 1.0, pretože na pozemkoch nie sú vykonané protierózne opatrenia 

v zmysle Wischmeier-Smithovej univerzálnej rovnice straty pôdy. 

 

Funkciami matematickej algebry sme zistili aj výsledok eróznej straty (Obr. 4.10), a 

takiež, že výpočet erózneho odnosu v prostredí GIS má oproti iným formám výpočtu mnoho 

výhod. Prácnosť výpočtu straty pôdy pomocou GIS je mnohonásobne menšia ako pri iných 

formách výpočtu. Najprácnejšia a časovo najnáročnejšia časť výpočtu erózie, nielen pomocou 

GIS, je získavanie a tvorba vstupných dát. Po získaní vstupných dát je možné vykonávať 

mnoho analýz aj veľkého záujmového územia v krátkom čase. V prostredí GIS je možné 

modelovať rôzne podmienky vzniku a priebehu erózie pôdy. Výrazne sa tým uľahčuje 

hľadanie optimálneho návrhu protieróznych opatrení.  
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Obr. 4.10: Intenzita straty pôdy (G) 

Rozsah intenzity straty pôdy (G) Rozsah v (ha)

Žiadna až slabá (0-4 t/ha/rok) 2089,86

Stredná (4-10 t/ha/rok) 1822,29

Vysoká (10-30 t/ha/rok) 642,59

Extrémna  (>30 t/ha/rok) - 105,5, 112,51 t/ha/rok 47,7  

5 Záver 

Práca je podaná ako celok charakterizujúci vybrané záujmové územie, po pedologickej 

a hydrologickej stránke. Naším záujmovým územím bolo povodie Teplica. Práca sa opiera aj 

o charakteristiku hydrologických procesov v území. Rieši prehľad o všeobecných 

teoretických poznatkov o erózii, predovšetkým o vodnej erózii pomocou využitia rovnice 

USLE na poľnohospodárskej pôde.  

Využitím univerzálnej rovnice straty pôdy vodnou eróziou (Wischmeier – Smith, 

1978) je v prostredí geografických informačných systémov možné lokalizovať a zobraziť 

miesta ohrozené odnosom pôdy, respektíve vodnou eróziou.  GIS významne uľahčuje výskum 

erózie, a zároveň umožňuje modelovať rôzne podmienky priebehu erózie pôdy. Taktiež nám 

dokáže nielen presne určiť intenzitu erózie, ale čo je najhlavnejšie, zároveň určuje presnú 

polohu v krajine. Zatriedením územia do jednotlivých stupňov eróznej ohrozenosti, sú 

výsledky nasledovné: 

Z vyššie uvedených výsledkov vyplýva, že dané územie je ohrozené potenciálnou 

vodnou eróziou na ploche 2212,58 ha poľnohospodárskej pôdy. Ako výstup hodnôt je 

na záujmovom území lokalizovanie miest s potenciálnym ohrozením a odnosom pôdy vodnou 
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eróziou a grafické znázornenie (viď. v kapitole 4 Výpočty a riešenia). Z uvedených údajov 

vyplýva, že riešené územie v poľnohospodársky využívanej krajine je ohrozené priamym 

odtokom, resp. eróziou pôdy, preto je potrebné venovať podstatne viac pozornosti ako 

doteraz, nielen výskumom, ale aj praktickým zavádzaním protieróznych opatrení.  

Ako bolo na uvedenom príklade priameho odtoku v povodí Teplica dokázané, vybraný 

GIS software je možné využiť nielen na priestorové analýzy, ale aj na modelovanie a výpočet 

niektorých hydrologických charakteristík.  

Všetky dosiahnuté výsledky sú interpretované prehľadne, zrozumiteľne a účelovo. 

Dosiahnuté výsledky sú interpretované mapovým spôsobom, ktorým je venovaná časť 

výsledky práce.  
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Abstrakt  

Poľnohospodárska krajina je typom krajiny, v ktorej sa stretávajú záujmy človeka 

v najširšom spektre. Popri lesnej krajine patrí k vývojovo najstarším typom antropicky 

ovplyvnenej krajiny. Vstupom človeka do krajiny a jeho poľnohospodárskou činnosťou 

nastalo výrazné pretváranie jej štruktúry, biodiverzity, ekologickej stability, ako aj celého 

krajinného obrazu. Najmä v súčasnej dobe zvýšeného antropického tlaku na prírodné 

prostredie, vystupuje do popredia potreba zhodnotenia možného nepriaznivého vplyvu 

spoločenských aktivít na narúšanie prírodnej rovnováhy v ekosystémoch. 

Pôda je nenahraditeľný prírodný zdroj, základný významný prostriedok 

v poľnohospodárstve, a hlavne dôležitou súčasťou životného prostredia. Prvoradý význam 

pôdy je daný potrebou výživy ľudstva, preto je dôležitá aj pre ekonomiku všetkých štátov. 

Stanovením erózneho ohrozenia pôdy sa zaoberajú vedci po celom svete. Eróziou 

pôdy sa u nás na Slovensku zaoberáme už viac ako 50 rokov, ale aj napriek tomu sa vysoké 

hodnoty odnosu pôdy stále vyskytujú. Erózia pôdy má zvláštne postavenie medzi 

degradačnými procesmi pôdy. Možno povedať, že je najzávažnejším degradačným procesom, 

ktorý často vedie k úplnému odnosu jemnozeme, a tým k zániku pôdy. Žiadny iný proces 

nepôsobí tak dlhodobo a veľkoplošne a žiaden neviedol doteraz k úplnému znehodnoteniu 

takej veľkej rozlohy pôdy, aký spôsobila erózia v mnohých častiach sveta. V Slovenskej 

republike je eróziou (vodnou a veternou) ohrozená približne polovica výmery 

poľnohospodárskych pôd. 

Cieľom práce je vymedziť v rámci územia povodia Teplice erózne najviac ohrozené 

lokality. Pre potreby návrhu protieróznych opatrení je potrebné postupovať krok za krokom. 

V prvých krokoch je potrebné, aby boli definované erózne faktory, ktoré sú potrebné 

pre výpočet erózneho odnosu pomocou Wischmeier a Smithovej rovnice. Pre potreby výpočtu 

nám poslúži program ArcGIS od spoločnosti ESRI. Potom, čo je vypracovaná mapa erózneho 

odnosu, sa na jej základe vytvorí mapa stupňov eróznej ohrozenosti pôd. Pred tým, ako sa 

pristúpi k samotnému návrhu protieróznych opatrení, je potrebné poznať sklonové pomery, 

pôdne, vegetačné pomery, ktoré sú limitujúcim faktorom pre intenzitu eróznych procesov.  

Návrhy sme spracovali v programe ArcGIS 10.1, čím sme dostali mapy odnosov pôdy, 

a na základe týchto poznatkov sme dospeli k výsledkom, že je potreba protieróznych opatrení.  

 


